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OGC Services — INSPIRE Focus

Introduction

With the new power of FME’s GML generation, we need ways to share this data. Our
new approach to supporting OGC web services accomplishes this. FME web services
are now hosted by publishing a service broker workspace to the data streaming
service on FMEServer. Instead of a workspace that just handles data conversion,
the service broker workspace handles the web message traffic — accepting requests
and generating responses according to the chosen service standard.

For WFS, this means the workspace accepts GET (a URL) or POST (XML
encoding) requests (GetCapabilities, DescribeFeatureType and GetFeature) and
generates the appropriate responses as XML or GML data streams. This approach
also supports XML filters - something the old built in WFS could not do. This
'service broker' workspace just needs to be published to FME Server's data
streaming service in order to function as a web service. Also, the workspace is
configured to support FME Data Inspector as a WFS client.
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FME workspace as web service broker for WFS

Any web service, such as WCS, WPS, WMTS or SOS could be supported by this FME
service broker workspace approach. All that is required is to understand the web
service protocol client / server requirements and configure accordingly. Additionally,
any complex XML / GML that needs to be transmitted via WFS can be supported,
whether INSPIRE*, AIXM, metadata/CSW etc.


http://fmepedia.safe.com/articles/How_To/INSPIRE-GML

New service types would require some setup / configuration to implement the
message handling compatible with that service standard, but this approach gives
the user control to configure, customize, update and extend their web services how
they want. This can be applied to other types of REST based web services beyond
OGC or INSPIRE applications.

The purpose of this training is to show how FME workspaces can be configured to
act as a service broker for INSPIRE web services, via data streaming on FME
Server.

* INSPIRE, or Infrastructure for Spatial Information in Europe, is a European Union directive
that aims to create a spatial data infrastructure of EU data, which would be used for policy
making across boundaries, especially environmental. The directive also aims to improve
public access to spatial information. Open standards such as the Open Geospatial
Consortium Web Feature Service (OGC WFS) are used to facilitate the exchange of INSPIRE
data. For more information please visit the INSPIRE website.



http://inspire.ec.europa.eu/index.cfm/pageid/48

Exercise 1: INSPIRE WFS for FMEServer

PART A: Reading Cadastral Parcels from Safe's demo WFS
In this exercise, FME Data Inspector will be used to read cadastral parcel data from
Safe’s demo WFS. A XML filter will be used to demonstrate the ability to query the

WFS.

1. Start Data Inspector. Under Tools - FME Options set background maps to
Stamen Maps and under parameters, select 'toner', to provide a suitable

backdrop.
& Select Dataset To View @
2. Open Dataset. Reader
Format: WFS (Web Format:  WFS (Web Feature Service) - E]

Feature Service)

Dataset:  http:/finspire-safe-software, fmedoud. com: 80/ fmedatastreaming INSPIRE,/INSPIRE_WFS. fmw

Dataset: http://inspire- Goard. System: | Read from source v [
safe- [ ok ][ canca |
software.fmecloud.com:8 1\
0/fmedatastreaming/INSP  Select Dataset to View
IRE/INSPIRE WFS.fmw

3. Click on Parameters...
Click the [] button to the right 3 WFS (Web Feature Service) Parameters Pg

of Feature Types, and choose
Cadastral Parcels. Note that
this fires a 'GetCapabilities'
request to INSPIRE_WFS.fmw,
which hosts the WFS service on
FME Server. Also, note that this
server only allows the selection
of one feature type at a time. If
you see nothing here then you
have a problem with the URL or

URL: 3m:30/fmedatastreaming/INSPIRE/INSPIRE_WFS. fraw
Prefer HTTP Post, if Available: [

WS Version: [L.L.0 -

> [] Use HTTP Authentication
> D Use Proxy Server

Constraints

m

Feature Types: "CadastralParcel {CadastralParcel}” B
Max Features: 5000
WFS Output Format:  textfxml; subtype=gml/3.1.1 -

¥ML Filter Expression: -Italian < Literal > < /PropertylsEqualTo > < Filter > E]

Application Schema

Application Schema: E] @
YOUF |nte rnet ConneCtlon . Numeric Identifier Attribute: E]
SRS Parameters
SRS Axis Order: [ - ]
- 3 GML Feature Properties
[ Select Feature Types Iﬁ
= Map Embedded Objects as: [htlributes - ]
CadastralParcel {CadastralParcel} Map Predefined Properties: [ |
7] NamedPlace {NamedPlace} T B T
GML Feature Properties - Attribute Handling
Q Select all Sorted Map Complex Properties as: [Nested Attributes - ] -
_—_—
= = — 3
— =

Select Feature Types

WFS Parameters - Cadastral parcels

4



http://inspire-safe-software.fmecloud.com/fmedatastreaming/INSPIRE/INSPIRE_WFS.fmw
http://inspire-safe-software.fmecloud.com/fmedatastreaming/INSPIRE/INSPIRE_WFS.fmw
http://inspire-safe-software.fmecloud.com/fmedatastreaming/INSPIRE/INSPIRE_WFS.fmw
http://inspire-safe-software.fmecloud.com/fmedatastreaming/INSPIRE/INSPIRE_WFS.fmw
http://inspire-safe-software.fmecloud.com/fmedatastreaming/INSPIRE/INSPIRE_WFS.fmw

Safe's INSPIRE demo requires no login, so ensure Use HTTP Authentication is
unchecked. Make sure the XML filter is empty and search envelope is
unchecked, and press OK.

After about 10-15 seconds the parcels data from Perpignan in southwest
France should appear. If your data appears off of Africa, then you set the
SRS axis order incorrectly - should be blank. If nothing happens after more
than a minute - hit stop and check all your settings, including search
envelope and try again. If your settings yield no data, the client can sit and
wait a long time before timeout.

4 Attributes 20 attribute(s)
areaValue (utf-16) 6587.66937890218

m2
2013-01-15T00:00:00

true

£me_geometry fme_aggregate
fme_type fme_collection
gml_id (utf-16) 14-alb6£95b-2275-41d6-9dbT7-211278bTca3E

1 original coordinate system (utf-16 EP5G:4258

136000870133

pireld. Id onld (utf-16)
onld.xsi_nil (utf-1. true
label (utf-16) 136000220133
naticnalCadastralReference (utf-16) 66136000A20133
validFrem (utf-16)
validfrom.xsi nil (utf-16) true
validTo (utf-16)
validTo.xsi_nil (utf-16) true
xml_type xml_aggregate
4 Geometry
4Multiple Geometry 2 Gecmetries

> Appearance References
Geometry 1 of 2: IFMEEolygon

s Geometry 2 of 2: IFMEPoint (2.90052677114111, 42.6897964267724)

Cadastral Parcel read with the WFS Reader

5. One parcel has a local ID of 136000AZ0063. Copy this ID, add dataset
again, and select a new WFS view with the same settings as before. Then
under parameters, go into the XML Filters Expression under Constraints and
paste the ID into an XML filter expression of the form:

<Filter><PropertyIsEqualTo><PropertyName>inspireld.Identifier.localId</
PropertyName><Literal>136000AZ0063</Literal></PropertyIsEqualTo>
</Filter>

XML Filter Expression IéJ

1 <Filter»<PropertylsEqualTo><PropertyName>nationalCadastralReference =
</PropertyName><Literal > ZaEltilifilifime /Literal></PropertyIsEqualTo
< /Filter>

Options = tnycaloz [ ok | [ cancel

h

XML filter expression for cadastral parcel localld



Note that spelling must be exact. This will be parsed by the WFS workspace
into _whereQuery = 'inspireld.Identifier.localld='136000AZ0063".

6. Click OK. The result will be a view containing only the parcel with local ID

136000AZ0063.
4 Attributes (20)

areaValue (encoded: utf-16) 15017.0516309541
areaValue.uom (encoded: utf-16) m2
beginLifespanVersion (encoded: utf-16) 2013-01-15T00:00:00
endLifespanVersion (encoded: utf-16)
endLifespanVersion xsi_nil (encoded: utf-16) true
frne_geometry (string) frme_aggregate
frne_type (string) fme_collection
gml_id (encoded: utf-16) id-ff4b9a7-5e8e-458b-8488-fd5d01 d9ea2d
gml_original_coordinate_system (encoded: utf-16) EPSG:4258
{inspireld Identifierlocalld (encoded: utf-16] 136000420063

inspireld Identifiernamespace (encoded: utf-16)
inspireld Identifierversionld (encoded: utf-16)

inspireld Identifierversionld xsi_nil (encoded: utf-16) true

label (encoded: utf-16) 136000AZ0063

nationalCadastralReference (encoded: utf-16) 66136000AZ0063

validFrom (encoded: utf-16)

validFrom.xsi_nil (encoded: utf-16) true

validTo (encoded: utf-16)

validTe.xsi_nil (encoded: utf-16) true

xml_type (string) xml_aggregate
4 IFMEAggregate (Multiple Geometry: 2 Geometries)

Front Appearance Reference <inherited_or_default_appearance=

rﬂﬂaﬂu

V”’“pk ® Back Appearance Reference <inherited_or_default_appearance=
er CC BY 3.0.@ i 4 Part 0: IFMEPolygon
der CORPY S8 "‘V‘Bnm,m Mame (encoded: utf-16) geometry

Cadastral parcel returned from using an XML filter expression

PART B: Reading Named Places from Safe's demo WFS:

Now, we will use Data Inspector to read named place data from the same WFS,
utilizing spatial query and XML filter capabilities. The same format will be followed
to read NamedPlace feature type.

1. In Data Inspector, choose 4[] Use Search Envelope
add a dataset with the WFS. Minimum X: 0
Open the WFS parameters, Minimum Y: 35
click the [...] button to the e
right of Feature Types, and e
choose Named Places onIy Search envelope for Named Place

(uncheck Cadastral Parcels).

2. This time we will set a spatial query for Named Places. Check Use Search
Envelope and set Min X=0, Min Y=35, Max X=5, Max Y = 47. Make sure the
XML filter expression is empty. Press OK twice. You should now see hamed
place data for West France, which overlaps parcel data.



Note: If you forget to change the spatial filter, you will get an XML parser error
since there is no data returned. To correct this, change the spatial filter to: Min
X=0, Min Y=35, Max X=5, Max Y=47.

Features Selected: 1|a
Property Value
Min Extents 3.2130000591278098, 43.351001739502003
Max Extents 3.2130000591278098, 43,351001739502003
< Attributes (18)
beginLifespanVersion (encoded: utf-16) 2013-01-01712:00:00
frne_geometry (string) fme_point
fme_type (string) fme_point
gml_id (encoded: utf-16) unknown.elcchflf-8e74-487 c-a841-f28524 dd163a
gml_eriginal_coordinate_system (encoded: utf-16) EPSG:4258
inspireld Identifierlocalld (encoded: utf-16) elcchflf-8e74-487 c-aB41-f28524dd163a
inspireld Identifiernamespace (encoded: utf-16) unknown
localType{0}.LocalisedCharacterString (encoded: utf-16) Region
localType{0}.LocalisedCharacterString.locale (encoded: utf-16) en-GB
name{0}.GeographicalName.language (encoded: utf-16) unknown
name{0}.GeographicalName.nameStatus (encoded: utf-16) standardised
name{(}.GeographicalName.nativeness (encoded: utf-16) standardised
name{0}.GeographicalName.pronunciation. ProenunciaticnOfMame. pronunciationIPA...
name{(}.GeographicalName.sourceOfName (encoded: utf-18)
name{(}.GeographicalName.spelling{0}.5pellingOfName.script (encoded: utf-16) Latn
name{0}.GeographicalName.spelling{0}.SpellingOfName.text (encoded: utf-16) BEZIERS
type{0} (encoded: utf-16) Administrative unit
xml_type (string) xml_point
4 :IFMEPaint 3.2130000591278098, 43,351001739502003
MName (encoded: utf-16) geometry
> Geometry Traits (1)

Named Place output using a spatial query

3. Finally, we select all the named places for Italy. Select add a new WFS
dataset for Named Place, and set up this XML filter, in the reader
parameters:

<Filter><PropertyIsEqualTo><PropertyName>GeographicalName language</Pro
pertyName><Literal>Italian</Literal></PropertyIsEqualTo></Filter>

Remember to uncheck the Use Search Envelope box or you will get an XML
parser error.



PART C: INSPIRE_WFS.fmw

For this exercise, we will add the CadastralParcel feature type to the INSPIRE_WFS-
Start.fmw workspace. To do this, you basically just need to replicate the logic that
is already there for NamedPlace. Note that the CadastralParcel custom transformer
is already there to parse your filters and make the correct query against the
database.

Note that this workspace requires FME 2014 or later to support the INSPIRE GML
Writer. Presently, this is a basic example with only 2 feature types, spatial extents
queries and one XML filter operation, though these can be extended easily by
following the approach laid out in this workspace.

1. Open C:\FMEData2014\Resources\INSPIRE\OGCservices-
INSPIREfocus\WFS\INSPIRE_WFS-Start.fmw. Add a CadastralParcel
destination dataset. Go to Writer - Import Feature Types, select outGML
[INSPIRE] as dataset, click OK. In the Import Writer Feature Types dialog,
open the INSPIRE parameters.

L &% Import Writer Feature T S
Under application schema, select feature types |- "= =70 P%

by themes, choose the CadastralParcel
INSPIRE theme. Click OK three times. Choose [oc ][ conel ]

Select Dataset: [outGML [INSPIRE] -]

the CadastralParcel feature type.
Import Writer Feature Types

[5 INSPIRE GML Parameters S

Feature Properties &

Map Predefined Properties:

Map Geometry Columns:

Feature Properties - Attribute Handling

Map Complex Properties as: [Nested Attributes - ]

Limit Mumber of Lists in Nested Attributes: [ - ]

m

Indude XML Dedaration in XML Fragments:
» [] Flatten XML Fragments

Application Schema

Select Feature Types: [byThemes V]
INSPIRE Themes: STEELElre [E
Application Schema: | <Unused> =
Validate GML Dataset Fie: [No -]
Show Feature Types from: [XSD Schema -]
Ignore xsi:schemal ocation in Dataset: [No g |
[ Help ] [ Defaults '] [ Ok l [ Cancel ]

Cadastral Parcel INSPIRE GML Writer Parameters
8



2. Add the CadastralParcel feature type name t0 [ . bucrie Porameters =
all AttributeFilters (AttributeFilter in the :
Process GET Request bookmark,
AttributeFilter_2 in the DescribeFeatureType
bookmark, AttributeFilter_3 in the
GetCapabilities bookmark).

Transformer

Transformer Mame:  AttributeFilter

Attribute Selection

Attribute to Filter by: | 9 _TYPENAVE ~ | [=]

Pozzible Attribute Values:

MarmedPlace -
3. Connect AttributeFilter CadastralParcel port """“'
to the CadastralParcel custom transformer, g
and enable the CadastralParcel transformer. tos e
Also, connect the output of CadastralParcel ] o o

custom transformer to the CadastralParcel
output feature type (INSPIRE Writer). This AttributeFilter parameters
takes care of the GetFeature request.

4. Connect CadastralParcel output from AttributeFilter_2 in the
DescribeFeatureType bookmark to a new AttributeFileReader_2. In the
AttributeFileReader_2 parameters, set the source filename to
...\schemas\CadastralParcels.xsd. This takes care of the DescribeFeatureType

request.
6‘:‘ AttributeFileReader Parameters &J 'E]Desc'ibeFeatLreType
Transformer - p—
- i o -,
-~ >+t AtributeFilter 2 3| i Atribu,.cReader 3}
Transformer Name:  AttributeFileReader_2 | B MamedPlace NE B
— P Output
= ¥ CadastralParcel
Parameters 5.} — < -
[P <Empty= ' . - : 1
Destination Attribute: _result b <Missing= [ '-\.?’ mm"'m—z‘i@,
- . T | b Output
Source Fiename: HE . > <Mul> b : 4
(b <Unfitersds =
[ Help ] [ Defaults '] [ 0K ] [ Cancel ]
DescribeFeatureType Workflow

AttributeFileReader_2 parameters



Add CADASTRALPARCEL subtemplate to XMLTemplater_2. Define the
Cadastral Parcels GetCapabilities Template as follows:

<wfs:FeatureType
xmlns="urn:x-inspire:specification:gmlas:CadastralParcels:3.0"
xmlns:base="urn:x-inspire:specification:gmlas:BaseTypes:3.2"
xmlns:gmd="http://www.isotc211l.0rg/2005/gmd"
xmlns:xlink="http://www.w3.0rg/1999/x1link"
xmlns:gml="http://www.opengis.net/gml"
xmlns:ogc="http://www.opengis.net/ogc"
xmlns:ows="http://www.opengis.net/ows"
xmlns:wfs="http://www.opengis.net/wfs"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
updateSequence="0" version="1.1.0"
xsi:schemalocation="http://www.opengis.net/wfs ../wfs/1.1.0/WFS.xsd">
<wfs:Name>{fme:get-attribute ("theme") }</wfs:Name>
<wfs:Title>{fme:get-attribute ("theme") }</wfs:Title>
<wfs:Abstract/>

<wfs:DefaultSRS>EPSG:4326</wfs:DefaultSRS>
<wfs:OutputFormats>

<wfs:Format>text/xml; subtype=gml/3.1.1</wfs:Format>
</wfs:0OutputFormats>

<ows:WGS84BoundingBox>

<ows:LowerCorner>-20 20</ows:LowerCorner>
<ows:UpperCorner>60 80</ows:UpperCorner>
</ows:WGS84BoundingBox>

</wfs:FeatureType>

In XMLTemplater_2, ROOT template:

Right after:
{fme:process-features ("NAMEDPLACE") }

Add in:
{fme:process-features ("CADASTRALPARCEL") }

&% XMLTemplater Parameters X

Transformer

Transformer Name: | ERENSE
Group Sub-Features By: Mo items selected. E] E]

Grouped Sub-Features are Consecutive: hd

Root Template

Port Source Termplate
o1 S oo . (5]

4 || Sub Templates

Port Source Template

NAMEDPLACE <whFeatureType ... () [=]
CADASTRALP.. <wfsiFeatureType ... (=)

XMLTemplater_2 parameters

10



/ —m
_ ‘ﬁ AttributeFilter_3 0%
B e ——

7. Connect the CadastralParcel output of et W
AttributeFilter_3 to the CADASTRALPARCEL :ENMEDM — e &
input of XMLTemplater_2. This completes the ,esmﬁ,_/][m‘%?
support for the GetCapabilities request. ' (> — E

CadastralParcel output to
8. Duplicate the NamedPlace Counter and Tester = CADASTRALPARCEL input

transformers. In-between the CadastralParcel
custom transformer and the INSPIRE GML Writer, add in the Counter and
Tester.

9. Examine the data flow for each primary WFS request type: GetCapabilities,
DescribeFeatureType, and GetFeature. Focus on GET as this is easier to

follow.

10.'Run with prompt' and see [ @ transiation Parameters 5=)
the behaviour of the User Parameters
workspace with different Service: WS ~
request types. This will Request: [GetCapabiities -] [+]
show how the output is an Version: 1.1 ~
XML document for Type name: | Namedplace 7] (=)
GetCapabilities, an XSD for Filter: z
DescribeFeatureType and a R =)
GML document for Bounding box - mirimum Y coordinate: E|
Get Featu re. Bounding box - maximum X coordinate: :

Bounding box - maximum ¥ coordinate: -
Bounding box - coordinate system:

11.Examine the output files in oending bor 5
an XML/text editor for each . mm =
of the above request types. Destination Geography Markup Language (GML) File: . \outGML.xml =)
XML output goes to
outText.xml, GML output ok J[ concel |

est tGML.xml. ;
g0 oou Run with prompt parameters

12.0pen the output GML in Data Inspector using the INSPIRE reader.
13.Validate your output using an XMLValidator and the relevent INSPIRE XSDs.
XMLValidator.fmw is a workspace set up for XML syntax and schema

validation. All is needed is for the XML input file and the application schema
file to be specified in the XMLValidator transformer.

NOTE: If at any point you cannot complete your configuration of CadastralParcels,
you can always start at step 8 with the completed workspace: INSPIRE_WFS.fmw.

11



PART D: Publishing your WFS to FMEServer

In this demo, INSPIRE_WFS.fmw will be published to FME Server, creating your
own WFS service on FME Server.

1. Modify workspace URL parameters so that GetCapabilities is configured to
point to your FMEServer and the correct repository is defined. For this
exercise, the default repository name is INSPIRE.

&% Translation Parameters &

User Parameters -

Service: m

NEEEE

Reguest: [GetCapabiIiﬁes

Version: 1.1

A

Type name: [NamedPIace

Filter:

Workspace URL:  §(FME_SERVER_WEB_URL) fmedatastreaming/INSPIRE/INSPIRE_WFS. fmw

m

Bounding box - minimum ¥ coordinate:
Bounding box - minimum ¥ coordinate:
Bounding box - maximum X coordinate:
Bounding box - maximum ¥ coordinate:
Bounding box - coordinate system:
Bounding box:

MaxFeatures: 5000

YN HHEM

Destination Geography Markup Language (GML) File: . YoutGML. xml

OK ” Cancel ]

User friendly parameters

2. Update WFS request parameters as needed (default theme, max features
etc.)

3. Set INSPIRE GML writer default parameters such as axis order, SRS etc.

4. Test run workspace locally using each of GetCapabilities,
DescribeFeatureType and GetFeature request types to make sure correct
output is generated.

5. Prepare for publishing by changing request back to GetCapabilities and

removing any filters before saving. The goal is to have user friendly default
parameter values.

12



6. Publish to FME Server data
streaming service. Select
Publish to FME Server. Enter
the details for your local server,
for which the default name is
localhost. Enter any required
authentication info. Click Next.

For this exercise use INSPIRE as
the repository name. Upload all
supporting resources by
choosing Select Files. Ensure all
of source_get.txt,
INSPIREdb.sdf,
GeographicalNames.xsd, and
CadastralParcel.xsd are
selected. Click Next.

For registered services, select
only Data Streaming. Then click
the Edit... make sure both the
Text File writer and GML writer
are published outputs. Click OK,
then Publish.

-
&% Publish to FME Server

A=)

Connect to an FME Server

g 8 Soucelf
+§ Destnall

J v NEB

I +—w NEB
- = Transhoq
= LAB

Connection Type
() Web Connection
URL: |<Unused>
@ Direct Connection
Host Mame: localhost

Port Mumber: 7071

Credentials

Username:

Pleasze enter the connection information for the FME Server you would like to connect to.

Password: |

[ Use Windows session credentials

M8 HF

] [ Defaults '] Test...

[ Help

][ Next > J[ Cancel

e

FME Server Connection

-
&7 Publish to FME Server

2 |

Publish Workspace

existing Workspace, select it from the list.

Select a repository and name for your Workspace on FME Server, If you want to update an

Repository Mame: [INSPIR.E

) [venes

Workspace Mame: | G 0 sl

Existing Workspace List:

4 @; Workspace
£ INSPIRE_WMS.frmw
&3¢ INSPIRE_WMS_GetMap.fmw
% INSPIRE_WMS_GetMap_png.fmw

Upload data files (4 file(s), 10.7 MB)

Select Files. ..

[ < Back ][ Next =

][ Cancel ]

\

Naming and Upload of Resources

.
&% Publish to FME Server

Register Services
Select the services that you would like to use.

FME Server is bundled with a

e Service Properties
S " [[] Catalog Service ‘E‘
To enable for use with one or = | &
more services, select the check a _Data Download _
box beside the desired service iData Streaming [ Edit. |
name. [ Job Submitter [ Edit. | -

< Back ][ Publish ][ Cancel

,
&% Edit Service Properties

S

Service Properties

Output Dataset(s) to Include: “outText [TEXTLINE]" "outGML [INSPIRE]"  [...]

Source Dataset to Override with Web Content: [sourceget [TEXTLINE]

1)

> Notify on Job Completion

:

Ok J [ Cancel

]

\

Registered Services

Published Outputs

13



7. Go to your FME Server by entering localhost as the path. You will be
required to enter a provided username and password. Under the INSPIRE
repository, verify that the workspace was published correctly.

Click on the workspace and click Run to make sure it works ok. A
GetCapabilities document should be output if that was what you set as your
default parameters. Home » Repositories » INSPIRE > INSPIRE _WFS iy

Registered Services

8. Then click on the workspace again, but this time select

Data Streaming

Configure. Here you can alter various parameters, P confiaure
then run the workspace. At the bottom of the page, &, Run

click Show Developer Information. Copy and paste the  Run or Configure
direct URL example into a web browser to ensure that =~ Workspace
the server can be called from an external client.

Home > Repositories = INSPIRE = INSPIRE_WFS.fmw = imedatastreaming > Configure
INSPIRE_WFS.fmw

INSPIRE_WFS fmw

JPublished Parameters |

Service WFS

Request: GetCapabiliies | =
WVersion: 11

Type name: NamedPlace
Repaository: INSPIRE

Filter:

Bounding box - minimum X coordinate:
Bounding box - minimum Y coordinate:
Bounding box - maximum X coordinate
Bounding box- maximum Y coordinate
Bounding box - coordinate system
Bounding box:

MaxFeatures: 5000

Show Developer Information  Reset Published Parameters

Configuration Parameters



Finally, try out your WFS from Data Inspector, by adding a WFS dataset and
using the core part of the path as the dataset path:

http://<Host>/fmedatastreaming/INSPIRE/INSPIRE WFS. fmw
Where <Host> corresponds to the name of your FME Server

Note that if you paste the above URL into a web browser and you correctly
set your default WFS request type to GetCapabilities, then this URL should
return a GetCapabilities response. Note that you will need to set your user
and password authentication in your browser and Inspector settings.

Example GetCapabilities response:

<wfs:WFS Capabilities xmlns:xlink="http://www.w3.0rg/1999/x1ink" xmlns:

wfs="http://www.opengis.net/wfs" xmlns:ows="http://www.opengis.net/ows"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-

instance" xmlns:ogc="http://www.opengis.net/ogc" xmlns:gml="http://www.
opengis.net/gml" updateSequence="0" version="1.1.0" xsi:schemalocation=
"http://www.opengis.net/wfs ../wfs/1.1.0/WFS.xsd">

<!-- Service Identification Section -->

<ows:ServiceIdentification>

<ows:Title>

WES Service Compliant with OGC WFS Specification Version 1.1.0
</ows:Title>

<ows:Abstract>

An OGC WFS Service created by Safe Software's FME Server
</ows:Abstract>

<ows:ServiceType>WFS</ows:ServiceType>
<ows:ServiceTypeVersion>1.1.0</ows:ServiceTypeVersion>
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PART E: Bonus WFS Exercise

This WFS does not produce valid output if no features are returned from the
FeatureReaders. This can easily happen if the constraints defined by the WFS
parameters are too

Obtain Features

Creates 1 feature

Count Features

Counts features received

[@lHandling if No Features Received

J

restrictive. For
example, if there is no

If the number of features is equal to 1,
no feature came through the INPUT port

f' o o

. | Creat StatisticsCalculator §0%

data in the extents or C-(v:;d @ b Statistics -) Tester2 i
XML filter(s) specified. o phe P
Thusl for a GetFeatu re [Prnvides an-attribute for filtering ]

request with such - Sampler

i@ < AttributeCreator 4Gt

filters, Inspector will (> Output

) . I Notsampled =
Slmply Y|e|d an XML '-#(VNO]NPUT {é}...
parser error, or worse SWRUT @.9 4<r, WFT_count j

> no_features

just stall and

eventually time out. NoFeaturesTester Workflow

To avoid this, use a NoFeatureTester custom transformer and StringConcatentor to
build an XML error message stating something to the effect:

<error>No features for provided WFS GetFeature request parameters</error>

This way, the WFS client knows why there is no valid data returned. Also, this is a
simple illustration as to how flexible and customizable this workspace based
approach to providing web services can be.

&% Tester Parameters &Jw
1. Connect the Passed outputs, from the s
MaxFeatures Counter transformers of both Transformer Name:  Tester_s
feature types, to a NoFeaturesTester. Testbeserpen
Pass Criteria
Pass Criteria: [OneTest(OR} -
2. Connect the NOINPUT port from the
NoFeaturesTester to Tester_5. 7ot Clauses
Left Value Operator  Right Value Megate Mode
1 Kk GetFeature 71 Automatic
3. Connect the Passed Tester_5 port to an
AttributeCreator_2 transformer. + - v
, :
&% AttributeCreator Parameters ﬁ

Transformer

Transformer Name:  AttributeCreator_2

> || Multiple Feature Attribute Support
Attributes To Set

Attribute Name

4+ — - =~ = =x

AttributeCreator_2 parameters
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Tester_5 parameters




r B
Text Editor - Basic u
String Parts
String Type String Value +
Kk =error>Extent or XML filter too restrictive. Mo data returned from the data.. | —
=
x
Concatenated Result
<error >Extent or XML filter too restrictive. No data returned from the database. <jerror > -
[ Switch To Advanced ] [ Help ] [ 0K ] [ Cancel
AttributeCreator_2 Text Editor
f Y
4. Connect the INPUT port from [ Testiter Parameters e
the NoFeaturesTester to Transformer
TestFi Iter 2 . Transformer Name:
Port Definitions
Test Condition Output Port

Else If areavalue ATTRIBUTE_IS_MISSIMNG

If namedplace_type ATTRIBUTE_IS_MISSING  CadastralParcel

MNamedPlace

Else <UNFILTERED>
+ — a4 - Edit... Duplicate
o [ s

TestFilter_2 parameters
The error handling should look like:

Error Handling - No Features /

If no features are returned from
the database, createan error message
which will be written out to outText file

[> Qutput ?—J

Tests whether there is data
output fromthe database

[» CadastralParcel

[> NamedPlace -
P <Unfiltered=
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OGC WMS for INSPIRE

WMS Background

The principles explored within the WFS exercise above apply equally to other web
services. Let’'s examine how we can build a WMS service from scratch.

Building a new web service requires 3 main components:

e FME workspace that provides data to the client via FME Server’s data
streaming service.

e GetCapabilities XML document that tells the client what services and data
layers are available.

e FME workspace that will act as the service broker for the web service. It
needs to accept service requests and transmit responses according to the
service specification requirements.

One fundamental difference between this exercise and the WFS one is that for WMS
we use one workspace to do the message handling and a separate one for the data
streaming. The reason we have to do this here is simple. To date, FME only allows
one type of MIME encoding per workspace. For WFS this isn’t a limitation since both
the service messages and the GML results are XML which are encoded as
application/xml. However, WMS is different. The GetCapabilities response is XML,
while the GetMap response is typically image/png or image/jpg. So these two
responses cannot coexist within the same workspace, at least not as of FME 2014.

To work around this we instead use 2 workspaces. One workspace simply listens for
GetCapabilities requests and transmits the appropriate response in the form of
application/XML documents. The other workspace parses GetMap requests and
transmits the actual WMS data responses in the form of image/png data. The key to
getting this to work is to edit the GetCapabilities document so that each service
request calls the appropriate workspace.
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Exercise 2: WMS Service Broker Workspace - GetCapabilities

1. Make a backup copy of the GetCapabilities.xml, and then open
C:\FMEData2014\Resources\INSPIRE\OGCservices-
INSPIREfocus\WMS\GetCapabilities.xml in an XML or text editor of your
choice.

2. Examine the different Request type defined, including GetCapabilities and
GetMap. Note how the URLs used point to different workspaces published to
FME Server’s data streaming service.

<Request>

<GetCapabilities>
<Format>application/vnd.ogc.wms_ xml</Format>
<DCPType>
<HTTP>
<Get>
<OnlineResource
xlink:href="http://localhost/fmedatastreaming/INSPIRE/INSPIRE WMS. fmw"
xlink:type="simple" xmlns:xlink="http://www.w3.0rg/1999/xlink"/>
</Get>
</HTTP>
</DCPType>
</GetCapabilities>
<GetMap>
<Format>image/gif</Format>
<Format>image/png</Format>
<Format>image/jpeg</Format>
<Format>image/svg+xml</Format>

<DCPType>
<HTTP>
<Get>
<OnlineResource
xlink:href="http://localhost/fmedatastreaming/INSPIRE/INSPIRE WMS GetMap p
ng.fmw" xlink:type="simple" xmlns:xlink="http://www.w3.0rg/1999/xlink"/>
</Get>
</HTTP>
</DCPType>
</GetMap>

WMS GetCapabilities response document - section showing request responses

3. Edit your GetCapabilities.xml. If you are running on a local FME Server
then leave this as is. If you want to run on an external FME Server then you
need to change all occurrences of localhost to the desired FMEServer host
name. Contact your instructor if you are unsure. Save your changes.

Next we need to set up the GetCapabilites and GetMap workspaces
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4. For the GetCapabilities workspace, open a new, blank workspace. Add a Text

File reader:
Reader format: Text File
Reader dataset: GETrequest.txt

5. Add a Text File writer as follows:
Writer format: Text File
Writer dataset: messageResponse.xml

6. Edit your reader and writer settings. Make sure your reader has ‘Read whole
file at once’ set to ‘yes’. Also, make sure the MIME type is set to

application/xml.

Next we need to create workspace parameters
so that key terms from the client’s GET
request can be parsed.

Essentially what happens is as follows. For the
following request URL:
http://localhost/fmedatastreaming/INSPIRE/INSPIR

E WES.fmw?SERVICE=WMS&REQUEST=GetCapabilities&VE
RSION=1.1.1

By examining the URL closely, we can see the
following parameters: SERVICE, REQUEST and
VERSION.

7. Create workspace level user parameters
and defaults as follows:

SERVICE = WMS

REQUEST = GetCapabilities (this way the
service defaults to a GetCapabilities even if
no request is specified.)

VERSION =1.1.1

We could add version handling here so that
the correct format of GetCapabilities.xml is
returned depending on what the client asks
for: WFS 1.1, 2.0 etc.
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4 [& GETrequest [TEXTLINE]
{:-:‘;} Source Text File(s): CAFMEData2014Resow
f@' Coordinate Systern: <not set>
4 {ﬁ} Parameters
iﬁ} Read Whaole File at Once: Yes
{83 Read Bottom Up: Mo
i5% Mumber of Lines to Skip: 0
§5% Mumber of Footer Lines to Skip: 0
iﬁ} Character Enceding (optional): <not se
€§} Advanced
B Feature Types
4 < | responseMessage [TEXTLIME]
{23 Destination Text File: responsehessagexml
-‘.@ Coordinate Systern: <not set>
4 {ﬁ} Parameters
i5% Overwrite Existing File: Yes
é3% Line Termination: Systern
€§} Write Last Line Terminator: Yes
i5% Character Encoding: utf-8
£33 Write UTF Byte Order Mark: Yes
da3 MIME Type: application,/xml
€§} Advanced
- = Feature Types
: ? Transformers
4 |![| Bookmarks
4 iﬁ} Uzer Parameters
4 {E} Published Parameters
ﬁ} [SERVICE] Service ; WMS
ﬁ} [REQUEST] Request : GetCapabilities
iﬁ} [VERSIOM] Version:11.1

T

WMS workspace user parameters



Also, it is worth noting from the navigator’s view of the parameters that the text
file reader is set to read the whole file at once. This is less important for URLs as
these are usually one line, but would be important if the input was HTTP POST.

Also note the MIME encoding.

8. Next add a ParameterFetcher so that we can use these values within the
workspace. Select each of SERVICE, REQUEST and VERSION and use the
default target attribute names as below:

Parameters To Fetch

Pararneter Mame Target Attribute il
ds% VERSION _VERSION =
% REQUEST [REQUEST] ||
d2h SERVICE _SERVICE iR
+ — i - F x

9. Add a TestFilter. We will use this to check which request and service types
the user has requested. Set up these test conditions:
If @Value(_REQUEST) LIKE GetCapabilities AND @Value(_SERVICE) LIKE
WMS; Output Port = GetCapabilities
Else If @Value(_REQUEST) LIKE GetMap; OutputPort = GetMap

Port Definitions

Test Condition Output Port

¥ @Valuel REQUEST) LIKE GetCapabilities AMND
@Value(_SERVICE) LIKE WS

Else If @Value( REQUEST) LIKE GetMap GetMap

GetCapabilities

Else <UMNFILTERED =

+ — a4 = Edit... Duplicate

Connect the GetMap and Unfiltered ports to a Logger so we can log
unexpected inputs.

10.Add an AttributeFileReader to pull in the content of GetCapabilities.xml for
streaming to the client.
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Set Destination Attribute = text_line_data

Source Filename = .\GetCapabilities.xml

&% AttributeFileReader Parameters ﬁ

Transformer

Transformer Name:  AttributeFileReader

Parameters

Destination Attribute:  text_line_data

Source Filename: | NEEoE e Sl E] E]
Source File Character Encoding: [Unicode 8-bit (utf-8) hd ] E]
’ Help l l Defaults 'l [ 0K ] [ Cancel ]

b

11.Connect the output of the AttributeFileReader to the text_line destination
feature type.

Your workspace should now look something like this:

1. Process GET Request [@)2. Generate GetCapabilities Response
P text_line HP terFatch
/.:;—/ SrEmetsIFeieher {é} Get URL parameters
[ Read GetCapabilities.xml from file J
-#TmFlller A’,:é} V
k_—_J
[ GetCapabiliies e 'KE" Attribu...eReaderich

—
(b GetiMap ] > OumpUt o b text_line )
. < Filter by request type = e .,/
| b <Unfilered= = \ —

web service message responses

L

Text File writer used for
‘ﬁE Logger_GetMap ot )

WMS service broker & message handling workspace

12. Publish your workspace to FME Server.
e Make sure your published parameters are set to valid default values
before you publish.
e Select File > Publish to FME Server
e In the wizard under ‘Connect to FME Server’, enter localhost (or
whatever the Server hostname is), and any required authentication
info.
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Next, on the ‘Publish workspace’ frame, make sure INSPIRE_WMS.fmw
is selected. Then click New under the repositories and define a new
repository called ‘INSPIRE’ or select it if it already exists.

Click on ‘select files’ and make sure Getrequest.txt and
GetCapabilities.xml are selected

Under ‘Register Services’ make sure Data Streaming service is
checked. Click on ‘Edit’ beside Data Streaming

&% Edit Service Properties &J

Service Properties

Output Dataset(s) to Indude: “responseMessage [TEXTLIME]™ EI

Source Dataset to Override with Web Content: |GEFrequest [TEXTLIME] - |

> Motify on Job Completion

Help [ K ]| Cancel |

L

Data streaming service properties during service registration
Click ‘Publish’

You should see the following message:

Successfully published to FME Server as 'INSPIRE_WMS.fmw'.

Server Host : localhost

Server Port : 7071

Username : author

Repository : INSPIRE

Target Name : INSPIRE_WMS.fmw

Resources Uploaded :

\\bester\pserv\Projects\INSPIRE\Training\FMEUC2014 _training\OGCservices-
INSPIREfocus\WMS\GetCapabilties.xml
\\bester\pserv\Projects\INSPIRE\Training\FMEUC2014 _training\OGCservices-
INSPIREfocus\WMS\GETrequest.txt

Services Registered : Data Streaming

Log for successful workspace publication to FME Server
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WMS GetCapabilities Bonus Exercise:

Right now the workspace should work fine so long as it gets valid input from the
client according to the OGC WMS standard. However, as with any standard, OGC
standards are interpreted slightly differently by different vendors. Sometimes
requests are encoded or composed differently.

To cover the potential of server / client miscommunication, add an error handling
section to address those cases where the service, request or version parameters do
not match what is expected or supported.

Hint: use the GetMap and Unfiltered outputs from the TestFilter, and add an
XMLTemplater that contains something like:

<error>
<unexpectedInput>
<warning>Unexpected Input Received from WFS client</warning>
<request>{fme:get—attribute("_REQUEST")}</request>
<service>{fme:get-attribute (" SERVICE") }</service>
<version>{fme:get-attribute (" VERSION") }</version>
</unexpectedInput>
</error>

Sample warning from INSPIRE_WMS.fmw for unexpected input

Note that warnings such as this should be viewable in the client’s log. Also, it is
often useful to troubleshoot OGC request problems using a web browser. At a
minimum, this message will display in any web browser when there is a problem
with a request, such as if you ask for something unsupported such as SERVICE =
WCS.

You have now published the main service broker workspace for your WMS service.
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Exercise 3: WMS Get Map Data Streaming

Now we need to configure and publish the workspace that handles the GetMap
requests and streams back the appropriate raster images. To do this we will build
up the workspace from scratch with the benefit of some custom transformers.

1. Open INSPIRE_WMS_GetMap_Start.fmw
2. Add a Text File Reader. You can select the same source dataset as before:

Getrequest.txt. Here this is a placeholder that allows the workspace to run
since the parameter values in this case come via the workspace parameters.

3. Add a ParameterFetcher after the text_line input. Configure it as follows:

Cfr} ParameterFetcher Parameters @

Transformer

Transformer Name: e i

Parameters To Fetch
Parameter Name Target Attribute i
€83 VERSION _VERSION
£ REQUEST _REQUEST
és% SERVICE _SERVICE 3
€53 LAYERS _LAYVERS
€53 BROX _BBOX
ﬂﬁ bhoxWest _bbox\West il
+ -_— s v E ¥

o] Coa

(Or as a shortcut just copy the ParameterFetcher and TestFilter from your
INSPIRE_WMS.fme workspace, and then add the new parameters.)

4. Add a TestFilter transformer after the ParameterFetcher. Configure it as

before with these test conditions:

If @Value( REQUEST) LIKE GetCapabilities AND @Value( SERVICE) LIKE WMS; Output
Port = GetCapabilities

Else If @Value( REQUEST) LIKE GetMap; OutputPort = GetMap

5. This time, connect a Logger to the GetCapabilities output, to capture
unexpected inputs, since here we expect GetMap requests only.
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. Connect an AttributeFilter after the TestFilter. Filter on the _LAYERS field.
Define possible values as NamedPlace and CadastralParcel.

. Connect the NamedPlace custom transformer to the NamedPlace output
port of the AttrbuteFilter and the CadastralParcel custom transformer to
the CadastralParcel output.

. Connect the outputs of the NamedPlace and CadastralParcel custom
transformers to a MapnikRasterizer.

. Configure it as below. Add inputs for NamedPlace and CadastralParcel. Set
NamedPlace to Text symbolizer and CadastralParcel to Polygon.

Under Raster Properties, set Columns to the WIDTH parameter and Rows to
the HEIGHT parameter.

&5 MapnikRasterizer Parameters @
Transformer
Transformer Mame: | [EGGE ]
Group By: Mo items selected. [I] B

Inputs

Layer Mame Symbolizer Style it

NamedPlace Text Edit.. ||=

CadastralParcel Polygon Edit...

+ — & » =T = Duplicate

4 Raster Properties

Size Spedification: [Columns and Rows b ] B
Mumber of Columns (cells): {E} S(WIDTH) B
Mumber of Rows (cells): {E} S(HEIGHT) E]
Cell Spacing: | <Unused:= -
Interpretation Type: [F‘.GBA32 A ] E]
» Background

> Ground Extents

| tep || Defauts | ok || cancel

he

MapnikRasterizer configuration
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10. Edit the MapnikRasterizer Text symbolizer for NamedPlace.
Set the text properties text field to:
name_geographicalname_spelling_spellingofname_text
Set the color to anything you wish.

11. Edit the MapnikRasterizer Polygon symbolizer for CadatralParcel. Select
any color you like.

12. Copy the ParameterFetcher and connect it to the output of the
MapnikRasterizer.

13. Add a PNGRaster Writer. Set it to fanout on _LAYERS. Set the output
directory to be '.’. Set the output coordinate system to be: LL84.

Your INSPIRE_WMS_GetMap.fmw workspace should now look something like:

Client Input

i Logger_text_line{c: g}
— (@) Error Response

1

. T(ﬁlFlIl -bilities é@}/—;\\
[ I+ Logged P’_
1
i) GetMap Request (Sl style Layers Output to WMS Image

74{“%&
e ———
- ParameterFetcher 45

CattrbuteFiter 82 yamedPlace {é"?\

\\—’—/
3 Dutput.__-__ — (> NamedPlace  p— 1 _Dt GetFeatureGET | MapnlkRaslenzer o8 Palamet .tcher_3 {6‘}

=1 | [ I CadastralParcel \‘ (> NamedPlace p-_--SEDS—__" £ NamedPlace Ouu:ut
-ﬁTestFmer @] ItD Er ‘;, —— { CadastralParcel
b GetCapabiliies fp (E——— ) n- Comnect Input
3 |)D<M'&; \Cada:'.‘tmlParoel o) v <_LAYERS> 1| ’, \
Biticition (b <tuuil> i rrr——— (> Raster
;—: 4 GetFeature_GET ) —

P <Unfitered> = [ <Unfittered> > (b CadastraParcel & (» <Rojected> >

Completed INSPIRE_WMS_GetMap.fmw data streaming workspace

14.Test run your workspace using ‘File > Run with prompt’. This is always a
good way to preview a workspace before you publish it to FME Server.
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15. Publish your workspace to FME Server.

Make sure your published parameters are set to valid default values
before you publish.

Select File > Publish to FME Server

In the wizard under ‘Connect to FME Server’, enter localhost (or
whatever the Server hostname is), and any required authentication
info.

Next, on the ‘Publish workspace’ frame, make sure
INSPIRE_WMS_GetMap_png.fmw is selected. Then select the
repository called ‘INSPIRE’ (created last exercise).

Click on 'Select Files’ and make sure Getrequest.txt and INSPIREdb.sdf
are selected.

Under ‘Register Services’ make sure Data Streaming service is
checked. Click on ‘Edit’ beside Data Streaming

r{» Edit Service Properties [&r
Service Properties
Qutput Dataset(z) to Indude: . [PNGRASTER]" E]
Source Dataset to Override with Web Content: |snurce_u:1et [TEXTLIME] - |
» Motify on Job Completion

Help | oK | | Cancel |

b

Data streaming service properties during service registration
Click ‘Publish’

You should see the following message:

Successfully published to FME Server as 'INSPIRE_WMS_GetMap_png.fmw'.

Server Host : localhost

Server Port : 7071

Username : author

Repository : INSPIRE

Target Name : INSPIRE_WMS_GetMap_png.fmw

Resources Uploaded :
\\bester\pserv\Projects\INSPIRE\Demos\WebServices\WMSservice\WMS_SDF\INSPIREdb.sdf
\\bester\pserv\Projects\INSPIRE\Demos\WebServices\WMSservice\WMS_SDF\source_get.txt
Services Registered : Data Streaming

Log for successful workspace publication to FME Server
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Exercise 4: Testing your WMS Workspaces on FME Server

Now that we have published the supporting workspaces to FME Server, it’s time to
test it out.

1. First, go to FME Server and verify that everything is published as it should
be. Go to the INSPIRE repository and confirm that you have
INSPIRE_WMS.fmw and INPIRE_WMS_GetMap_png.fmw published.

-

&2 localhost/fmeserver/repo: %
L

<« C | [ localhost/fmeserver/repositories/INSPIRE o,
i Apps ] Dean (] Demos CJFME [CJGIS CJIT (CJ Mews [ Projects (O] Safe (O] Surveying (O Travel (] Weather »

admin - Help -
Home = Repositories = INSPIRE

/v Repository: INSPIRE

viviy
|
] Mame ~ Type Last Updated
Home ) INSPIRE_WFS.fmw & 2014-04-17 16:17:21
Re positories INSPIRE_WFS.fmw -
INSPIRE_WMS.fmw & 2014-06-04 11:45:02
Jobs B INSPIRE_WMS frw -
Notifications - - INSPIRE_WMS_GetMap_jpeg.fmw & 2014-05-14 00:03:55
ot locz et INSPIRE_WMS frmw -
AR | INSPIRE_WMS_GetMap_png.fmw & 2014-06-04 15:22:23
INSPIRE_WMS fmw B =
FME @ Server @ 1984 - 3
2014
Safe Software Inc.

FME Server view of INSPIRE OGC repository

2. Click on INSPIRE_WMS.fmw, then on ‘Configure’, and then on ‘Show
Developer Information’

You should see URL samples such as:

Direct Url Example

http://UHURA/fmedatastreaming/ INSPIRE/INSPIREiY/\]MS . fmw?SERVICE=WMS&REQUEST=GetCa
pabilities&VERSION=1.1.1

3. Copy this URL, open Data Inspector, select Open Dataset, and choose WMS.
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http://uhura/fmedatastreaming/INSPIRE/INSPIRE_WMS.fmw?SERVICE=WMS&REQUEST=GetCapabilities&VERSION=1.1.1
http://uhura/fmedatastreaming/INSPIRE/INSPIRE_WMS.fmw?SERVICE=WMS&REQUEST=GetCapabilities&VERSION=1.1.1

4. Paste the URL into the dataset field:
http://UHURA/fmedatastreaming/INSPIRE/INSPIRE WMS. fmw?SERVICE=WMS&REQUE
ST=GetCapabilities&VERSION=1.1.1

Click on the Layer List [...], and select one layer such as NamedPlace

F5 WMS (Web Map Service) Parameters I&

WMS Connection -

URL: http: /fUHURA ffmedatastreami

» ] Use HTTP Authentication
> |:| Use Proxy Server

Constraints

Layer List: {MamedFPlace} E]
Split Reguests by Layer: [

m

Map Options
Transparent Background: ||

Map Width: 1500

Map Height: | 1500]|

Cutput Format:  image/png -
Map SRS5:  EPSG:4326 -
Help ] [ Defaults "] [ K ] [ Cancel

L

WMS Reader parameters

Make sure background maps are turned off as this can interfere. Click OK and
see what happens.

If you have any problems examine the log carefully. You can always click on
any of the URLs embedded in the log to try opening them in your web
browser. This will often help you determine if you are missing some key
connection element such as a login.

Without any spatial extents the labels on NamedPlace will not show up well.
Try entering the following extents: xMin=0, yMin=33, xMax=12, yMax=45.
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http://uhura/fmedatastreaming/INSPIRE/INSPIRE_WMS.fmw?SERVICE=WMS&REQUEST=GetCapabilities&VERSION=1.1.1
http://uhura/fmedatastreaming/INSPIRE/INSPIRE_WMS.fmw?SERVICE=WMS&REQUEST=GetCapabilities&VERSION=1.1.1

You may have to experiment with the extents to get the results you want.
Note that if you choose extents that are too restrictive or result in 0 features

returned, you will likely just get a WMS reader error message.
VQ) FME Data Inspector @M‘

File View Camera Tools Settings Window Help
SR RacErEle@Vaq QA e IV
Display Control & X | view1 Feature Information & X

<@ @ \{iewl 1) Features Selected: olofd 4 »
4 [V] £ INSPIRE_WMS.fmw?SERVICE=WMS...

] CadastralParcel (1)

4 Raster Point Info
Row and Column 187,127
Ground Location 1.72358, 41.969.
Band 0 (RED8) 0
Band 1 (GREENS) 170
Band 2 (BLUEB) 0

'S

\

< | n | »

EPSG:4326 X: 29990 Y: 45.7784

Data Inspector WMS client to INSPIRE_ WMS.fmw deployed on FME Server

Congratulations! You have just implemented your own WMS on FME Server
simply by configuring a workspace- without any coding.

WMS Bonus Exercise:

Option A:

Add logic to your INSPIRE_WMS_GetMap_png.fmw workspace to handle 0
features returned. You could detect 0 features coming back from the
database and then generate an appropriate warning. Or you could try to
detect that the result from MapnikRasterizer is not a raster. Then you could
return a default or blank raster so that you always generate a valid raster,
result regardless of the request.

Option B:

Add another layer to your WMS. You can publish virtually anything you want.
You will need to add the corresponding layer name, FeatureReader and
styling to the INSPIRE_WMS_GetMap_png.fmw workspace. You will also need
to make sure you reproject everything to LL84 it comes from some other
reference. Or you could simply add a label layer to the parcels.
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Appendix A. WFS - Workspace Documentation

INSPIRE_WFS.fmw
OVERVIEW

This workspace comprises an INSPIRE WFS when published to the FME Server data
streaming service.

The local server url is:
http://localhost/fmedatastreaming/INSPIRE/INSPIRE WFS.fmw

Safe Software's WFS demo server url is:

http://inspire-safe-
software.fmecloud.com/fmedatastreaming/INSPIRE/INSPIRE WFS.fmw

It also supports writing INSPIRE GML using the XSD enabled INSPIRE GML Writer
available as of FME 2014. It accepts GetCapabilities, DescribeFeatureType and
GetFeature requests, either as GET URL or POST XML. Also, it supports Filter
expressions.

When you send an HTTP POST to FME Server, it automatically overrides the input of
this workspace with the post body. Note this means you need to have only one
input and you assume that it is HTTP POST WFS XML. If there is a POST, then the
POST body is the WFS request, such as the WFS GetFeatures XML with the
embedded XML filter query. The workspace supports FME Viewer and FME Data
Inspector WFS clients. It should support third party WFS clients as well.

Setup:

1. Modify workspace paths to make sure source database is accessible by
FeatureReaders in the theme data extraction custom transformers (CadastralParcels
and NamedPlace).

2. Update workspace parameters as needed (default theme, max features etc.)
3. Set GML writer default parameters such as axis order, SRS etc.

4. Test run workspace using each of GetCapabilities, DescribeFeatureType and
GetFeature request types to make sure correct output is generated

5. Prepare for publishing by changing request back to GetCapabilities and removing
any filters before saving. The goal is to have user friendly default parameter values.
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http://localhost/fmedatastreaming/INSPIRE/INSPIRE_WFS.fmw
http://inspire-safe-software.fmecloud.com/fmedatastreaming/INSPIRE/INSPIRE_WFS.fmw
http://inspire-safe-software.fmecloud.com/fmedatastreaming/INSPIRE/INSPIRE_WFS.fmw

6. Publish to FME Server data streaming service. Upload all supporting resources:
source_get.txt etc. Make sure both Text File writer and GML writer are published
outputs. Note xsds are no longer need to be uploaded as they are included with the
INSPIRE writer. If you wish to use a draft or newer schema than what is delivered
with FME you will need to make sure these are uploaded.

USAGE NOTES:

Make sure you publish with a non-xml source so that by default the XML test will
fail.

Also make sure parameter Filter = "" and Request = GetCapabilities by default

GeoServer uses TypeNames and FME Viewer client uses TypeName

If getting an error message when making a request, run the following WFS
diagnostics. First, try to make a simple request, such as setting max features to a
low number to see whether the WFS is responding. Then, if the WFS is responding,
examine the syntax of the desired request to check for errors.

OUTSTANDING
Currently only handles WFS 1.1 / GML 3.1.1.
Only handles queries to one theme at a time.

Need to add support for WFS 2.0. This should be straight forward - just need to
update template headers and use GML 3.2.1 geometry extraction. Needs to handle
POST extents query

Limited error handling in the workspace. Only able to output a specific error
message if no data is received from the database. Bad feature requests may
output unhelpful messages, just yields an XML error. We should detect this and
return a valid GML or XML error feature. For example, if the XML filter has a syntax
error, log may return an XML parser error, when it would be more descriptive to
state that it does not have a not valid name.

Cannot currently make POST requests for CadastralParcels, only can make POST
request for NamedPlace

Reading Safe's INSPIRE WFS
Sample Requests and Filters

Use this URL:
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http://inspire-safe-
software.fmecloud.com:80/fmedatastreaming/INSPIRE/INSPIRE WFS.fmw

Backup / development Server:

http://inspire-safe-
software.fmecloud.com:80/fmedatastreaming/INSPIRE/INSPIRE WFSdev.fmw

*** Only query one theme at a time NamedPlace or CadastralParcels but not both
at once***

Sample GetFeature request:

http://inspire-safe-
software.fmecloud.com:80/fmedatastreaming/INSPIRE/INSPIRE WFSdev.fmw?SER
VICE=WFS&VERSION=1.1.0&REQUEST=GetFeature& TYPENAME=CadastralParcel&M

AXFEATURES=1111

CADASTRAL PARCELS QUERIES:
Parcels XML FILTERS:

<Filter><PropertylsEqualTo><PropertyName>inspireld.Identifier.localld</Property
Name><Literal>136000AZ0063</Literal></PropertylsEqualTo></Filter>

(Generates: " _whereQuery' has value
“inspireld.Identifier.localld='136000AZ0063")

<Filter><PropertyIsEqualTo><PropertyName>gml_id</PropertyName> <Literal>id
-ff84b9a7-5e8e-458b-8488-
fd5d01d9ea29</Literal></PropertylsEqualTo></Filter>

<Filter><PropertyIsEqualTo><PropertyName>nationalCadastralReference</Proper
tyName><Literal>66136000AZ0492</Literal></PropertylsEqualTo> </Filter>

Parcels SPATIAL QUERY:

0 to 5, 40 to 50 (W France)
GEOGRAPHIC NAMES QUERIES:
NamedPlace XML FILTERS:

<Filter><PropertylsEqualTo><PropertyName>GeographicalName_language</Prop
ertyName><Literal>Italian</Literal></PropertyIsEqualTo> </Filter>

<Filter><PropertyIsEqualTo><PropertyName>geographicalname_spellingofname_t
ext</PropertyName><Literal>Roma</Literal></PropertylsEqualTo></Filter>
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http://inspire-safe-software.fmecloud.com/fmedatastreaming/INSPIRE/INSPIRE_WFSdev.fmw?SERVICE=WFS&VERSION=1.1.0&REQUEST=GetFeature&TYPENAME=CadastralParcel&MAXFEATURES=1111

NamedPlace Spatial query:
0 to 5, 40 to 50 (W France)

0 to 25, 42 to 48 (should cover both Italy and S France so results overlap with
parcels)

Can also get schemas from:

http://inspire.ec.europa.eu/schemas/cp/3.0/CadastralParcels.xsd etc.
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=

SAFE SOFTWARE’

Safe Software values its customers” opinions very highly.
For questions and concerns, please use the general feedback page at: www.safe.com/contact, or
email the Training Manager directly at: training@safe.com.

Copyright © Safe Software Inc. 2014. All rights reserved.
"FME" is a registered trademark of Safe Software Inc. All other product names may be trademarks or registered trademarks of their respective owners.

4102-01-A



	COVER FME Server OGC Web Services
	OGCServices-INSPIRE-focus

